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Abstract 
Bathymetric maps are maps that show the topography of the bottom of a lake. The topography is 

shown in the same way that topographic maps describe terrestrial landscape – with contours. The 

maps are based on depth soundings taken from a boat floating on the surface of the water body. These 

maps are used to calculate a variety of parameters for a lake such as area, perimeter, maximum depth, 

littoral area, and volume. Bathymetric maps are used for a wide variety of environmental assessment 

purposes.  

This document presents the procedures and accuracy standards used to collect data and to create 

bathymetric maps for the Ecosystems Branch of the B.C. Ministry of Environment. This is the third 

version and builds on the work that has come before. Significant recent changes in depth sounder and 

GPS technology provided the impetus for this update. These changes have made this type of 

bathymetric survey easier, more efficient, more accurate and, finally, more affordable. 
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1. Introduction 
This manual describes the standards and procedures for carrying out a bathymetric survey and 

producing a lake bathymetric map according to the B.C. Ministry of Environment Fish and Fish 

Habitat Inventory and Information (FFHII) standards. Bathymetric maps are based on depth 

soundings taken from a boat floating on the surface of the water body. These maps are used to 

calculate a variety of parameters for a lake such as area, perimeter, maximum depth, littoral area, and 

volume. 

The British Columbia Ministry of Environment (MoE) and its contractors collect field data for 

producing bathymetric maps. The data collected can be used by different groups within the Ministry 

for a wide variety of purposes. For example, the Ecosystems and Fish and Wildlife groups use 

bathymetric information to identify sensitive habitats and to ascertain the potential of a lake to 

support fish based on the habitat available. The Water Stewardship Program requires bathymetric data 

for managing water licenses, monitoring existing or potential reservoirs, forecasting river flow, and 

managing watersheds in general. The information generated by bathymetric maps may also be used 

for managing Riparian Management Areas (RMAs), parks, and other land and water-related 

decisions.  Finally, because of their description of habitat and shoal area, bathymetric maps are also 

highly utilized by anglers as an aid to recreational fishing activities. 

This standard specifically presents the requirements for producing a bathymetric map that adheres to 

the Fish and Fish Habitat Inventory and Information (FFHII) standards as part of the 

reconnaissance (1:20,000) fish and fish habitat inventories.  While the information presented 

here may be helpful in collecting bathymetric data for other applications (in the absence of their own 

specific standards, it does not officially cover other uses. The maps produced as part of this standard 

are not designed for navigation and should not be used for that purpose. 

The technology for doing these surveys has evolved over the years. In the earliest days of lake 

bathymetry work in BC, rudimentary maps were created by rowing transects across a lake with a 

knotted, weighted line, lowering the line at set intervals (measured in oar strokes) and then recording 

these spot depths on a map. More recent incarnations of the method used sonar technology in the 

form of the Furuno and Lowrance X- 15 and X-16 sounders, which recorded depth readings on a 

paper (chart) strip. These readings were then manually transferred onto a paper map of the lake that 

was created through airphoto interpretation. In both of these methods, depth contours were manually 

interpolated from the point soundings. 

The more recent incarnation of the method,  presented here, takes advantage of the significant recent 

changes in Geographic Information Systems (GIS), depth sounder and Global Positioning System 

(GPS) technology that have made doing this type of bathymetric survey easier, more efficient, more 

accurate and, finally, more affordable. Recreational-grade fish finders and sounders that combine 

sonar and GPS technology and which can also digitally record data are now available for less than a 

thousand dollars (2009 prices). 

This document outlines the steps involved in planning and carrying out a bathymetric survey in the 

field, post-processing the collected data and creating a final bathymetric map and associated data. Part 

2 describes the pre-field work, including information on how to obtain the required background data / 

mapping, and how to produce lake outline maps. Parts 3 and 4 provide information on survey layout, 

equipment operation, and data recording. Parts 5 and 6 describe preparation of the final map, 

including data processing, bathymetric calculations, and map specifications. A project on Sowerby 

Lake is used as an example throughout the manual. 
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Standards and interpretive accuracies that the government requires from all contractors using GPS 

technology are described in The British Columbia Standards, Specifications and Guidelines for 

Resource Surveys Using Global Positioning System (GPS) Technology; Release 3.0, March 2001, 

Geographic Data B.C.  
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2. Production of the Lake Outline Map 

2.1 Aerial Photographs and Satellite Imagery 

Some type of remotely sensed image of the lake (either aerial photograph or satellite image) is 

required to gather information about a lake and to prepare a lake outline map. Hardcopy or digital 

images can be used but because the rest of the process is digital, using digital airphotos or satellite 

images that have been orthorectified will make the process much easier and will feed directly into the 

next phase. This is the recommended method and therefore the one that will be explained here. 

2.1.1 Identifying the best image to work from 

Given the choice, in most instances, working with a digital orthophoto is preferable to working from a 

satellite image. Orthophotos typically have a higher resolution and better detail for differentiating the 

features of a lake. However, if no digital orthophoto is available for the area, a satellite image may 

have to be used.  

Regardless of the acquisition platform (plane or satellite) the best image will be selected using the 

following criteria: 

1. the largest scale image available 

2. the most recent coverage 

3. an image with the least shadow, glare, and other obscurities (i.e., clearest definition of lake 

outline) 

4. a colour image is usually better than black and white. 

To identify the appropriate air photo or satellite image, first determine the location of the lake on the 

most current 1:20,000 TRIM (Terrain Resource Information Mapping) map base. This can be done in 

GeoBC‟s iMap by using the 1:20,000 mapsheet grid layer and then turning on the airphoto flight lines 

/ coverage layer to see what the most recent and best resolution images are for the area. Whatever 

image is selected, it must be at a scale large enough and clear enough so one can accurately trace the 

lake outline and locate features when viewed in the GIS. This is also a good time to ensure that no 

bathymetric map already exists for the lake by checking the bathy lake layer 

(WHSE_FISH.BATH_SURVEY_MAP_SHEETS_SVW) in the Land Resource Data Warehouse 

(LRDW).   This step can also be carried out using the Fish Information Data Query (FIDQ)  for those 

that do not have access to the LRDW. 

Once the best image has been identified, import it into the GIS platform (See Section 5.1 and 

Appendix D) and prepare it for digitizing. For government employees and contractors, the images can 

be found in the image warehouse. Other users can find and purchase the images through the GeoBC 

orthophoto discovery / order page. 

2.2 Lake Outline Maps 

Lake outline maps can be used for a variety of purposes as either a hard copy or digital map. For field 

use, a standard laser photocopy of the enlargement on waterproof paper may be used to show cardinal 

points and the location of other useful features associated with the lake (i.e., roads, trails, campsites, 

stream flow directions). This map can also be marked up while in the field to record field photo 

numbers and directions, lakebed substrate types, aquatic plant distribution, shoal areas, and location 

of net and minnow trap sets, limnostation sites, benchmarks, macrophyte beds, fish sightings and any 

other field observations. These points must be transferred to the final presentation version of the 

http://webmaps.gov.bc.ca/imfx/imf.jsp?site=imapbc
http://a100.gov.bc.ca/pub/fidq/bathyMapSelect.do
http://ilmbwww.gov.bc.ca/bmgs/products/imagery/orthophoto.htm
http://ilmbwww.gov.bc.ca/bmgs/products/imagery/orthophoto.htm
http://ilmbwww.gov.bc.ca/bmgs/products/imagery/orthophoto.htm
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digital lake outline map at the end of the field survey. All of these types of features should also be 

captured electronically on the GPS / Sounder unit by using waypoints with comment notes. 

A digital lake outline map (Figure 2.1) is created in the GIS environment by on-screen (or heads up) 

digitizing of the outline of the lake from the digital orthophoto or satellite image. This is saved as a 

polyline feature. This polyline will be used in the QA/QC process of checking the collected data and 

as a boundary in the surface interpolation phase. 

For small to medium-sized lakes, enlarge or reduce the image to fit the standard 8.5"  11" (21.6  

27.9 cm) sheet (preferred) or 8.5"  14" (21.6  35.6 cm) sheet, as required. An 11"  14" outline map 

may be used to accommodate a long lake. 

 

Figure 2.1 Example of an outline map of Sowerby Lake that could be taken into the field for 
writing notes on. 
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3. Field Equipment and Operation 
A bathymetric survey requires a minimum of two people: one boat operator and one sounder operator. 

Comments and instructions in this document notwithstanding, users of this manual are required to 

comply with any safety policies, guidelines and practices required by their employers and/or 

WorkSafeBC.  See Appendix C for bathymetry-related equipment and supply list. Some related 

requirements are described below. 

3.1 Lake Survey Form 

If the bathymetric survey is part of a Reconnaissance (1:20 000) Fish and Fish Habitat Inventory, then 

the Lake Bathymetry section (Figure 3.1) of the Lake Survey Form must be completed (see 

Reconnaissance (1:20 000) Fish and Fish Habitat Inventory: Lake Survey Form Field Guide - 

Version 2.0, 2008). The data required includes littoral area, maximum depth, benchmark height, 

maximum water level, and benchmark type and location comments. 

 

 

Figure 3.1 Lake bathymetry section of the lake survey form. 

3.2 Boat and Sounder Requirements 

A watercraft capable of safe operation on the lake being surveyed is required to carry out a 

bathymetric survey.  While this could be a small self-propelled vessel such as a canoe, the most 

common setup is a boat of minimum draft (i.e., inflatable or small aluminum „car topper‟) fitted with 

a short-leg outboard (gas or electric) motor.  The configuration must be suitable for use in relatively 

shallow water conditions when near the shoreline but also large enough to handle any weather and 

water conditions that may arise on the lake being surveyed.  This will be a larger vessel on larger 

lakes where wind and waves can come up quickly.  Whichever type of watercraft is chosen, the 

transducer must be mounted so that it remains at a constant depth (to be accounted for during the data 

manipulation phase) and also far enough away from the propeller to avoid turbulence and potential 

interference in the sonar signal. 

The sounder / GPS unit must also be capable of digitally logging (recording) the collected X, Y 

(surface location), and Z (depth) data for subsequent downloading and import into a GIS package. 

These standards have been developed using a Lowrance LMS-330C that was purchased for less than 

$1000 (2006). Any substitutes must have comparable functionality, features and setting capabilities in 

terms of the GPS (positional accuracy) and sounder (depth accuracy). 

The GPS component of the instrument must be able to differentially correct its position by 

communicating with another reference system – be it the Coast Guard Referencing Network or the 

United States based WASS system.  The positioning system must also record co-ordinates in a 

standardized format that can be easily translated into UTM co-ordinates.  Finally, the data logging 

component of the system must allow for review and QA/QC of the data.  In other words, there must 

be a data validity field as part of the recorded data string for both the horizontal (co-ordinate) and 
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vertical (depth) which allows uncertain data points to be deleted from the dataset.  See Step 2 of 

Appendix D for how to do this using the Lowrance system. 

Before use, calibrate the sounder according to the manufacturer‟s instructions. 

3.2.1 Boat Operation 

For bathymetric surveys, data quality can be compromised by a number of factors. Excessive speed 

can cause turbulence under the transducer, resulting in poor soundings. Going too quickly near the 

shoreline may also increase the likelihood of damaging the boat, motor, or transducer by striking the 

lake bottom (rocks), submerged trees, or other debris. Going too close to the shore is also 

counterproductive because the sounder will often lose the signal in shallow water (<1-2 m, depending 

on the substrate and vegetation). With the Lowrance family of sounders, for example, a lost signal is 

indicated by a flashing depth value showing on the screen. Once this happens, the operator of the 

vessel must slow down and wait for the sounder to „re-acquire‟ a good signal and for the depth values 

to be valid again. 

3.2.2 Sounder Operation 

Consult the owner‟s manual for details on sounder operation. These will vary widely from one 

manufacturer and model to the next, but keep some general guidelines in mind: 

1. Always test the unit before going in the field (particularly if surveying a remote lake) to 

become familiar with its operation and to ensure that the unit is tracking and recording both 

the location and depth data correctly. There will be many settings to adjust, such as depth 

alarms, chart speed, ping speed, keel / transducer offset, etc. 

2. Set the operating frequency of the sounder to provide the best resolution and detail in the 

soundings. Many of the current Lowrance models feature dual frequency so that the operator 

can select the correct frequency, given the average depth of water that will be surveyed. For 

example, the Lowrance LMS-330C can be set to either 50 kHz or 200 kHz. The 200 kHz 

setting would be for water less than 100 m deep and the 50 kHz setting for deeper water 

because it has a wider cone angle. 

3. Experiment with the sensitivity (also known as gain) settings to ensure that enough echoes 

are being picked up by the receiver. If the sensitivity is set too low, the signal from the 

bottom of the lake will be weak; if the sensitivity is set too high, the receiver will collect too 

much noise and it may be difficult to differentiate detail from the signals. Many new sounders 

have an autosensitivity function that can be handy, but be sure to test it and understand how 

to override it if necessary.  Set the sounding frequency such that you are collecting enough 

data to get good coverage of the lake but not so much that you will be overwhelmed by the 

volume of data to process during map production.  A good rule of thumb is a recording rate of 

one data point per second.  This will result in closely spaced data points in areas where the 

boat speed was low and slightly wider spacing where the boat was travelling faster. 

4. Manual spot soundings should be done at the beginning of a survey to calibrate the sounder 

and make sure the transom offset is correct. Spot soundings are depths taken manually using 

a metre stick or weighted measured line, depending on the depth. 
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4. Field Procedure and Data Collection 
A bathymetric survey involves conducting soundings while traversing the surface of a lake and 

deriving a bathymetric map from the collected data. This was traditionally done by using transects 

that were typically straight lines running from one known point to another. Two types of transects 

were used in traditional bathymetry for sounding operations: E-line and transverse transects. An E-

line (or Exploratory Line) is a sounding transect that traverses the full length of the lake along its 

main axis, and is used to roughly determine the maximum depth of the lake basin. Transverse 

transects were then run perpendicular to the E-line, traversing the breadth of the lake, as parallel to 

each other as permitted by lake morphology, to determine the lake basin topography. 

With the new electronic equipment and software available now, this structured method of parallel 

transects is not strictly necessary. Although it does tend to ensure an even coverage, parallel tracks 

that run back and forth across the width of the lake do not need to be as structured as in earlier 

methods. For example, the transects do not need to be pre-planned on the lake outline map or run 

from one known point to another – they can go wherever the surveyor wishes so long as there is an 

adequate and even coverage of the surface of the lake in the end. 

The difference between older methods and the current method is that when a GPS unit is integrated 

with the depth sounder and an X-Y coordinate is collected in the same data string as the depth at that 

location, the bottom of the lake is located in three dimensions. In the post-processing / map-making 

phase, the map maker does not have to make the manual connection between X-Y coordinate and the 

corresponding depth. As such, the data collection phase in the boat can be much more unstructured, 

allowing the surveyor to spend more effort on areas of particular interest (the deepest part of a lake or 

perhaps a unique, shallow spawning area by doing repeated passes). Similarly, if large areas appear 

quite uniform, the transect spacing can be increased without fear of misinterpreting the bottom 

profile. 

4.1 Shoreline Cruise 

To begin the depth sounding process, cruise around the lake shoreline to form an electronic outline of 

the lake on the sounder screen. Get as close as possible to the shoreline without hitting bottom or 

submerged rocks or logs. Do not venture into water so shallow as to lose the signal (less than 1m-2m 

depth depending on the substrate).  All of the data logged during the shoreline cruise (also sometimes 

called the shoreline crawl) is used in the production of the final map.  The depths between the 

shoreline crawl „data trail‟ and the photo-interpreted shoreline (set at a depth of zero) will be 

interpreted so it is good to get as close to the shore as possible.  Note all inlets and outlets, and a 

general layout of the surrounding terrain, including a good place to locate the benchmark if one does 

not already exist. Use this initial shoreline cruise to conduct a general inspection of the lake shore, 

bays, islands, etc., to identify factors that will affect the final sounding process – notably aquatic plant 

beds, logs and debris, and extreme shallow areas (including rocks) that may prohibit the use of an 

outboard motor. Record this information on the hard copy lake outline map. 

4.2 E-line 

The E-line is a minimum standard requirement of a fish and fish habitat inventory and must be 

completed even if a full bathymetric map is not a requested product of the inventory. As water 

samples and profile measurements must be taken from the deepest part of the lake (if possible), an E-

line, at the most basic level, provides an indication of the most likely point of maximum depth(s) for 
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locating the limnological station(s). Figure 4.1 shows the most appropriate choice for the E-line in a 

hypothetical lake; additional transects 1 and 2 may be used to determine depth of other basins. 

 

Figure 4.1 E-Line placement on a hypothetical lake. 

4.3 Transect Coverage 

Once the shoreline cruise and E-Line soundings have been completed, the survey team can begin 

doing transects back and forth across the lake, perpendicular to the E-line and working from one end 

of the lake to the other. The exact locations of these transects do not need to be predetermined as in 

previous methods, but some general rules will help to ensure good coverage of the lake. This in turn 

affects the quality and quantity of the data gathered and, therefore, the final bathymetric map. The 

following guidelines should be observed when planning the layout of transects. 

1. Transects should be roughly parallel to each other and as close to perpendicular to the shore as 

possible. 

2. The distance between transects is discretionary, but must always be close enough to allow for 

reasonable interpolation by the 3-D surface generating application during the final mapping 

process. 

3. The more transects, the more accurately the depth contours can be mapped. Generally, the smaller 

the lake, the closer the transects can be. In the case of an irregular lake or one that appears to have 

a complex bottom profile, more transects are required to determine the shape of the lake bottom 

and water volume. 

4. All areas of the lake must be mapped, but particular emphasis should be placed on headlands, 

bays, bedrock outcrops, rock pinnacles, shoals and islands, if any. 

5. Where depth permits, transects should also provide good coverage of all significant embayments. 

6. While establishing and completing the map, the survey team must continually monitor the results 

and conduct additional transects as required (e.g., in areas exhibiting dramatic differences in 

depths for two adjacent transects) to produce an accurate and detailed end product. If adjacent 

transects give highly disparate readings, speed should be reduced and, if necessary, readings 

confirmed with a weighted line. A transect or pass perpendicular to the original tracks can also be 

useful in corroborating or rejecting the data collected in the earlier tracks. 

4.4 Spot Sounding 

Spot soundings are depths taken manually (a metre stick or weighted measured line) in places where 

it is impractical, unsafe or impossible to run a transect. For example, spot soundings would be taken 

in a shallow area around a small island that has a shoal area covered by water, but too shallow for 

boat or sonar. Occasionally, spot soundings are used in densely vegetated aquatic areas because the 

1

2

"E" line
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sonar cannot pick up a signal. Generally however, in the case of the shallow areas between the 

shoreline cruise route and the actual shoreline, the interpolation routine sets the shoreline at 0 m depth 

and then interpolates between that and the first set of readings that may be offset by 2 to 5 m linear 

distance (average – depends on bottom profile) into the lake. Manual spot soundings should also be 

done at the beginning of a survey to calibrate the sounder and make sure the transom offset is correct. 

4.5 Referencing Depth Soundings with a Benchmark 

Depth soundings obtained from a lake are specific to the lake level at the time of the survey. Lake 

depth may vary through seasonal events such as flooding or evaporation or with developments over 

the course of time (e.g., development or breaching of beaver dams or natural debris plugs). Therefore, 

all depth data must be referenced to a permanent object, called a benchmark, which can be traced over 

time. 

A benchmark can be any immovable structure around the lake, such as a permanent dock or booming 

chain anchor bolt. The preferred marking is a small eyebolt and tag, fixed in a bedrock crevice with 

epoxy resin, and this method should be used where possible. Another common method for 

establishing a benchmark in a fisheries survey is to drive a large spike, leveled horizontally, into a 

mature, healthy tree near the water‟s edge and to clearly mark it with a blaze and/or paint. A spike in 

a tree must be clearly marked because it can present a hazard to loggers or other users. If a benchmark 

already exists at a lake, then all new depth data must be referenced to it, even if a new benchmark is 

established. Generally, benchmark height is set 2.0 m above the current water level. 

Precisely record the location of the benchmark (including height above and distance from shoreline at 

time of the survey) on the Lake Survey Form so that it is easy to locate and use as a reference point in 

future investigations. Also, photo-document and mark the benchmark location on the lake outline 

map. 

After installing the benchmark, measure and record its vertical height above the water surface. The 

simplest and most appropriate method for lake surveys is to use a line level. This is a small 

(pocketsize) bubble level that can be suspended from light line. One end of the line is attached to the 

spike or eye at the benchmark and the other, with the level attached, is held parallel to and over the 

water surface. The level should be placed exactly in the middle of the line. This is to compensate for 

the sag in the line. The vertical distance is then measured using a metre stick or tape. 

A sighting level (Locke level, Abney level, precise level) or a clinometer (Balkwill and Coombes, 

1994) can also be used in lieu of a line level to measure the benchmark height. A clinometer should 

only be used if the benchmark is within 3 m of the observation point. For greater distances, more 

precise instruments should be used. The surveyor stands at the water edge and locates the benchmark 

placement from a horizontal sighting. The height above the water level will represent the distance 

between the level of the surveyor‟s eye and the ground or water surface. 

4.6 High-Water Mark 

Estimate the normal high water level of the lake also when taking benchmark height measurements. 

The high water level is usually considered the mean maximum over a two-year period, using staff 

gauge measurements. If gauges and the previous year‟s levels are not available, examine the shoreline 

for any plain rock faces or trees near the water that show evidence of water level heights. 

A high water level that is often reached will leave a mark in the lichens on a rock face. Some lichen 

thrive on being submerged in vernal flooding while others expire on a day‟s inundation. Wave action 

will also clean away some weathering debris so there may be a band that is relatively plain with a few 

excursions above it that are faintly visible. Measure this band‟s height above the water level as 
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accurately as possible. If there are no clear indicators on the rocks, then examine tree trunks for 

evidence. In many areas, ice will damage trees if the maximum levels are reached in cold weather. 

These marks are clearly visible, and their heights easily measured. If the survey is done shortly after 

spring freshet in an area where the trees are releasing pollen, mud, needle, or pollen lines may be 

visible. If you know whether this high water event is normal, subnormal, or above normal, then use 

the mud, needle, or pollen line to approximate a high water level, using other indicators as tools. 

Other indicators are driftwood berms, driftwood or floating grasses caught in shrubs, small wave-cut 

benches in side slopes, erosion under trees (where extreme shade has kept the ground bare) and small 

scars on the forest floor, as well as differences in vegetation, especially ferns, mosses, graminoids, 

and herbaceous plants. 

4.7 Final Transect Map 

The final transect map is produced in the office after all sounding observations and recordings have 

been gathered. It is based on the layout of the transects and spot soundings used and is created by 

overlaying the georeferenced data points on the digital image of the map. Figure 4.2 shows the final 

transect map for Sowerby Lake. 

The transect map should show the following: 

 Transects, shown as a series of data points, the separation between them will show the speed of 

the boat during different stages of the survey. 

 The direction of travel, marked with a short arrowhead at regular intervals. 

 Spot soundings, accurately positioned and depth shown. 

 Shoals, rocks, and other stationary hazards. 

 Benchmark location. 
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Figure 4.2 The final transect map for Sowerby Lake. 
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5. Preparation of Final Bathymetric Map 
The final bathymetric map (hardcopy and digital version) is the main product of this process. It 

assimilates and displays all of the point data collected in an easily interpreted format that users are 

familiar with. Bathymetric maps use contours or lines of equal depth to illustrate the topography of 

the lake bottom that is hidden below the water. 

5.1 Generating the Final Map 

The final bathymetric map for Sowerby Lake is shown in Figure 5.1. This map was produced using 

the technique outlined in Appendix D, which uses various computer software packages to achieve the 

final result. Generally, the workflow involves the following steps: 

Step 1. Collect the XYZ data while traversing the surface of the lake in a boat (Section 4). 

Step 2. Export this data from the data logger / sounder/ GPS unit into a spreadsheet and prepare it 

for importing into a GIS package. 

Step 3. Spatially overlay the data points on top of an orthorectified image in the GIS package to 

ensure the correct location for the data and to QA/QC all the data points. 

Step 4. Export the „cleaned‟ data points into a 3-D surface generating package (such as Surfer) 

and interpolate between all the points to create a „grid‟ or „wire frame‟ of the lake bottom. 

Step 5. Use the „grid‟ file to generate contours and then import the contours back into the GIS 

package. Select an appropriate contour interval and then overlay the contours on the 

digitized outline of the lake (shoreline) to create the final bathy map. The placement and 

smoothing of contours by computer is strictly mathematical, but may require some 

adjustment by a trained person with respect to the geomorphology of the basin. With 

respect to contour intervals, it is important to select an interval that is small enough to 

provide an adequate description of the lake‟s bathymetry, but not so small as to create a 

cluttered map. In every case, however, the 6-m contour must be mapped, where the lake is 

deep enough. In the example of Sowerby Lake, since this is a relatively shallow water 

body for its area, there is room to use a 1-m contour interval and show each of the 11 

contours without too much crowding or clutter (Figure 5.1). 

Note: Although some bathymetric programs may use smaller contour intervals to derive more 

accurate lake volume measurements, the production maps should conform to the rule of thumb 

given above. 

The detailed steps associated with this process with specific instructions for Lowrance (SonarViewer), 

ESRI (ArcMap), Microsoft (Excel) and Golden Software (Surfer) software packages are outlined in 

Appendix D. Although users are not required to use these specific software packages, they must be 

able to replicate the functionality and results generated in the examples. 
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 Figure 5.1 The final bathymetric map of Sowerby Lake. 

The steps above will provide the basic outline of the lake and the contours that fall within that area, 

but the map also requires other components, including a text box, north arrow, index map, etc. The 

details of what is required to complete the map are included in Section 6.2 Bathymetric Map 

Checklist. An example of a final bathymetric map text box is shown in Figure 5.2. 

 

Figure 5.2 The bathymetric map text box for Sowerby Lake. 
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5.2 Calculating Lake Volume, Area, and Mean Depth 

An advantage of using computer software to produce a bathymetric map by generating a three-

dimensional surface is that all area / volume calculations can be automatically obtained, both overall 

and by stratum. 

The total surface area and perimeter of the lake is easiest to calculate in the GIS program. These are 

part of the basic parameters provided for all polygon features, which is the type of feature the 

digitized outline of the lake becomes in the GIS workflow. To calculate the littoral area, simply 

subtract the area of the polygon defined by the 6-m contour from the total surface area.  

Surfer allows for calculation of lake volume through the Grid | Volume command, which gives the 

volume between an upper and lower surface. If the depth points for the lake are given in negative 

numbers, they represent the lower surface, which is then subtracted from the horizontal value chosen 

for the upper surface. For example, to calculate the entire lake volume, assign zero to the upper 

surface. Similarly, to calculate the volume of water below the 10-m contour, assign a value of 10 to 

the upper surface. 

In providing results, the following must be included, with standard rounding procedures as indicated: 

1. Total surface area: to the nearest 100m
2
 or ±1.0% max. 

2. Surface area at 6m contour (littoral area): to the nearest 100m
2
 or ±1.0% max. 

3. Volume (by stratum, and total): to the nearest 10,000m
3
 or ±1.0% max. 

4. Shoreline perimeter (lake and islands): ±10 m if lake <100,000m
2
, and ±100m if lake 

>100,000m
2
. 

5. Maximum depth: to the nearest 0.5m if >6m, and to the nearest 0.1m if <6m. 

6. Mean depth: (= total volume ÷ surface area) to the nearest 0.1m. 

5.3 Bathymetric Equipment Data Sheet 

If the bathymetric survey is part of a Reconnaissance (1:20 000) Fish and Fish Habitat Inventory, then 

the following data sheet must be completed for each full bathymetric survey on a primary lake, and 

submitted with the bathymetric map for that lake. 
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Bathymetric Equipment Data Sheet 

 

 Global Positioning System (GPS)  

Are locations differentially corrected?  Yes  No 

Accuracy  

Equipment used  

Software used  

       

  

 

Bathymetry 

Location methods  

Sounder make and model  

Boat speed (km/hr range)  

Boat type (optional)  

Motor specifications (optional)  

Software/Method mapping: 

used contouring: 

 quantification: 
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6.  Deliverables 
All bathymetric mapping projects require a set of hard copy and digital deliverables. 

6.1 General Project Submission Requirements 

1. One complete digital copy of the deliverables must be submitted through the fish data submission 

process. One complete hardcopy and one complete digital copy of deliverables are to be sent to the 

appropriate Regional Ministry office. 

2. Copies of the digital map, appendices, and applicable attachments must be provided in PDF 

format. The Ministry must be able to reproduce the entire hardcopy report from the PDF files 

submitted. 

3. Please do not use special fonts in the hardcopy or digital reports and maps. Arial and Times New 

Roman (True Type fonts) or Helvetica and Times (PostScript fonts) must be used for all report and 

mapping text. Use only standard Mapping fonts provided by the Ministry for map symbols. 

(Appendix A) 

For convenience, two checklists are provided in this section: 

6.2. Bathymetric Map Checklist 

6.3 Supporting Documents Checklist 

6.2 Bathymetric Map Checklist 

Hardcopy Map  

□ Final map produced in black on white, standard size (ANSI B or larger) paper 

□ Final map computer generated  

□ Outline and all contours completely closed, except for partial shoal definition contours 

□ All contour lines numbered and all numbers perpendicular to the bottom of the sheet 

□ All measurements in metres 

□ 6m contour interval included (in heavier line weight) for all lakes deeper than 6m  

□ Maximum depth included within each deepest contour 

□ North symbol “fish” right side up, not lying on its back and pointing to the top half of the sheet 

□ Direction of flow and a gazetted name (if available) for all streams  

□ Benchmark location indicated 

□ All symbols correspond to bathymetric mapping symbols listed in Appendix A 

http://www.env.gov.bc.ca/fish_data_sub/
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□ Approximate position of lake indicated on the location map using an arrow and a star 

□ Linear scale on the map situated near the lake  

 

Statistics at the time of survey section completed 

□ Lake Surface Elevation (metres above sea level) 

□ Surface area (square metres) 

□ Volume (cubic metres) 

□ Estimated annual fluctuation (metres) 

□ Mean depth (metres) 

□ Maximum depth (metres) 

□ Perimeter (metres) 

□ Area, 6m contour (littoral area of the lake) 

□ Height of benchmark above water level (metres above sea level, if known) 

□ Type of benchmark (e.g., spike in tree, bolt in concrete, etc.) 

 

Header block 

□ Officially gazetted name (if no official name exists, then use a local or alias name followed by an 

asterisk) 

□ Watershed code number according to the Freshwater Atlas (FWA) 

□ Waterbody Identifier  

□ UTM co-ordinate for centre of lake (the standard UTM coordinate ZEN format of 7 digits easting 

and 8 digits northing defines 1 metre precision) 

□ MU (management unit)  

□ Method of preparation of final map  

□ Contour interval used 

□ Technical check 

□ Date of completion of final map (month/day/year e.g., September 18, 2008) 

□ Revision date  
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□ Approved 

□ Scale decimal based and set to “100s” level 

□ NTS map sheet number is at 1:50 000 scale 

□ All NTS sheets used are recorded in full (e.g., 104 G/9, 104 G/10) 

□ Name of surveyor and company/agency 

□ Lake outline source 

□ Date of survey (month/day/year e.g., July 17, 2008) 

6.3 Supporting Documents Checklist 
 

Digital Products - GIS Files / Data 

□ Original Raw .SLG (or equivalent) files downloaded from the sounder  

□  „LakeNameCleaned‟.CSV file with cleaned XYZ data points 

□ Spatial polygon file showing outline of lake 

□ Spatial point file (Figure 4 -Transect Map) of cleaned and corrected XYZ data with UTM co-

ordinates and depths in metres (extraneous / incorrect data removed) 

□ Spatial polygon file showing the area between the shoreline and the 6m contour line 

□ Digital Orthophoto or Satellite image  

□ ArcGIS .mxd file with all relevant layers included  

□ All maps must be in UTM projection 

□ TRIM 1 to be used as map base for sample plans and all mapping products 

□ Final bathymetric map in PDF format – showing all details outlined in Section 6.2 (contours, 

scale, north arrow, header block, statistics, etc.) 

 

Calculations (specify what software was used to calculate these values) 

□ Lake volume calculation 

□ Surface area calculation 

□ Area to 6m contour calculation 

□ Mean depth calculation 
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Equipment 

□ Bathymetric equipment data sheet 

 

Reference Data 

□ Bench mark reference 

□ High water mark reference 

□ Field notes (original hard copy) 
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Appendix A: Bathymetric Mapping Symbols 
Appendix A provides the names, symbols and feature codes for the features needed to produce a 

bathymetric map according to B.C. Ministry of Environment Fish and Fish Habitat Inventory and 

Information (FFHII) standards.  A “feature code” is used to identify the feature in a Geographic 

Information System (GIS), and remains linked to the feature even if the symbol does not translate into 

a graphic symbol in another GIS program. 

The majority of these symbols occur in the BC Environment style file (bcenv.style). If accessing the 

government GIS system, the bcenv.style file can be added to a GTS ArcMap session by going to 

Tools | Styles | Style Manager and then selecting the bcenv style in the Style Manager. 

For contractors outside of government, the bcenv.style file can be obtained through: 

Scott Sharp  

Spatial Technology Analyst - GIS Services Unit  

GeoBC Infrastructure Services Branch  

Integrated Land Management Bureau  

Ministry of Agriculture and Lands  

Scott.Sharp@gov.bc.ca 

mailto:Scott.Sharp@gov.bc.ca
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APPENDIX A: Bathymetric Mapping Symbols 

 Feature Symbol Feature code Digital Drawing Specifications 

1.  
 

 

SHORELINE  

GA27110000 Line weight - 0.8 mm 

2.  
 

WATER COURSE 

-definite 

-indefinite 

-intermittent 

 

 

GA24850000 

GA24850140 

GA24850150 

Line weight – 0.6 mm 

 

Line weight – 0.6 mm, L=15mm, S= 

1mm 

 

Line weight – 0.6 mm, L=10mm, 

S=5mm 

3.  
DIRECTION OF 

FLOW ARROW 
 

 

KB14250000 Line weight – 0.35 mm 

4.  
 

SPLIT DRAINAGE 

 

 

 Line weight – 0.35 mm 

5.  
 

FALLS 

 

     

PI30004000 Line weight – 0.35 mm, Length – 2-4 

mm, 

 9 point type 

6.  
 

FALLS ZONE 

 PI30004000 Line weight – 0.35 mm, Length – as 

required,  9 point type 

F
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 Feature Symbol Feature code Digital Drawing Specifications 

   

 

7.  
 

 

RAPIDS 

 

 

 

GA23500110 

 

GA23500000 

 

GA23500120 

Line weight – 0.35 mm, Length – 2-4 

mm, 

  

Line weight – 0.35 mm, Length – 2 mm,  

area - as required, Italic  9 point type 

8.  
 

 

ROCKS OR 

BOULDERS 
 

 

GE25350000 Italic 9 point type “X” uppercase 

9.  
 

COBBLES OR 

STONY BEACH  

 

GE01800130 Irregular circles about 1.0 mm diameter, 

Line weight – 0.25 mm 

10.  
 

COBBLE OR 

STONY SHOAL 
 

 

GE27000130 Dotted boundary, Line weight – 0.5 mm, 

Dots – 0.3 mm, 

Open Dots – about 1.0 mm diameter  

 Line weight – 0.25 mm 

F
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 Feature Symbol Feature code Digital Drawing Specifications 

11.  
 

SANDY BEACH 

 

GE01800140 Dotted pattern with 0.3 mm dots 

12.  
SAND SPIT 

 

GE01800150 Dotted fill with 0.3 mm diameter dots 

13.  
SANDY SHOAL 

 

 

GE27000140 Dotted boundary line  

Line weight - 0.5 mm 

Dotted fill with 0.3 mm diameter dots  

14.  
EMERGENT 

VEGETATION 

 

 

GB15300150 

 

 

 

Broken line weight – 0.35 mm,  L=4mm, 

S=2m 

Symbols – line weight 0.25 mm, 

2.5 X 3.0 mm ovals, 2 arcs – 4.0 mm 

axis, length – 3.0 mm, one 3.0 mm 

straight line or from code file 
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 Feature Symbol Feature code Digital Drawing Specifications 

15.  
WETLAND, 

MARSH, SWAMPS 

 

Marsh: GC90100000 

Swamp: GC90200000 

Broken line weight – 0.35 mm,  L=4mm, 

S=2m 

Symbols as shown in 0.25 mm line 

weight 

 

 

16.  
MUSKEG 

 (TREED MUSKEG) 

 

 

GC18950000 Symbol line weight 0.25  

Broken line boundary: 0.35 line weight. 

 

 

17.  
FLOODED TREES 

 

 

GB11350000 Symbols as shown in 0.25 mm line 

weight, dashed line segments in 0.30 

mm line weight 

18.  
FLOATING LOGS 

 

 

WA00101120 Partial arcs in pattern as shown  of  0.5 

cm circle in 0.35 mm line weight  

19.  
LOG JAM  

 

 

WA00101110 0.7 cm wide square with “X” made of 

0.5 cm intersecting lines, all in line 

weight of 0.35 mm 
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 Feature Symbol Feature code Digital Drawing Specifications 

20.  
SPRING 

(unclassified) 
 

 

 

GA28750000 0. 5 mm diameter circle and “tail” in line 

weight of 0.35 mm 

21.  
SPRING 

(classified) 

 

 

 

GA28750110 0. 5 mm diameter circle and “tail” in line 

weight of 0.35 mm, 10 pt uppercase for 

classification 

22.  
DAM  

 

 

PI30007000 0.7 cm wide square in line weight of 

0.35 mm, 

Symbol in line weight of 0.5 mm, size – 

as required 

F
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 Feature Symbol Feature code Digital Drawing Specifications 

23.  
BEAVER DAM  

 

 

PI30002000 

 

Line weight - 0.5 mm, 6.0 mm circle, 

tangent 1.5 mm thick, 4 mm long.  

Length as requested.  

 

24.  
BEAVER 

HUT/LODGE 
 

 

 

GA08450110 Line weight - 0.5 mm, 10 point type, one 

half ellipse (major axis 12.0 mm, minor 

8.0 mm) tangent 1.5 mm thick, 4.0 mm 

long. Length as requested 

 

25.  
CONTOURS 

 

 

HA06200110 Line weight - 0.3 mm. 

Line weight for the 6 m. contour only -

0.5 mm  

 

 

26.  
DEPTH NUMBERS 

 

 

KB14250110 Dot - 0.5 mm diameter, numbers 8 point 

type italic, labeled parallel to bottom of 

sheet & right of dot 

 

27.  
CONTOUR 

NUMBERS 

 

 

HA06200000 Numbers in 16 point type, parallel to 

sheet bottom edge.  

 

BL
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 Feature Symbol Feature code Digital Drawing Specifications 

28.  
PILINGS OR 

DOLPHINS 

 

 

CR21300000 1.0 mm diameter dots  

 

29.  
LOG BOOM  

 

WA00101130 Line weight - 0.3 mm. 

 Symbols – 1.0 X 5.0 mm rectangles, 5.0 

mm apart, joined by a single line.  

 

30.  
FERRY ROUTE 

 

AQ10800000 Symbol is filled Ogive, 5.0 mm long, 2.0 

mm wide at the base, dashed line weight 

- 0.25 mm, line =2.0 mm, space = 

1.0mm  

 

31.  
FLOAT PLANE 

BASE 

 

 

AQ00800110 Symbol is 5.0 mm circle with anchor as 

shown in diagram. Line weight - 0.35 

mm  

 

32.  
VESSEL 

ANCHORAGE 

 

 

AQ00800000 Symbol of anchor as shown, in line 

weight - 0.35 mm anchor shaft 5.0 mm 
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 Feature Symbol Feature code Digital Drawing Specifications 

33.  
NAVIGATIONAL 

LIGHT 

 

 

GQ16350000 Exclamation mark" symbol in 250 point 

type or as pictured.  

 

 

34.  
MARINA 

 

 

BL17000000 Symbol 5.0 mm circle, 0.35 mm line 

weight, uppercase letter M in 10 point 

type  

 

35.  
BOAT RAMPS 

 

CQ15800000 Symbol to match approximate scale in 

line weight 0.3 mm, word "Ramp" in 9 

point type 

 

36.  
WHARF, DOCKS, 

BREAKWATERS 

 

Wharf: CQ33450000 

Breakwater:GE030500

00 

Open wharf - to scale in line weight 0.3 

mm. Solid wharf to scale in extent, line 

width 0.5 mm 

 

37.  
PUBLIC ACCESS 

RECREATION 

AREA, PARKS, etc. 

 

AL20150000 9 point type text, line weight 0.35 mm, 

line segment 3.0 mm, space 1.0 mm  

 

38.  
CAMPSITE 

 

Serviced: AL03900000 

Unserviced: 

AL03900100 

Outline in 0.35 line weight, fill as shown 
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 Feature Symbol Feature code Digital Drawing Specifications 

39.  
PICNIC SITE 

 

 

AL21150000 

 

Symbol drawn in line weight 0.35 mm  

 

40.  
BENCHMARK 

 

 

FB18650000 

 

Symbol 5 mm circle line weight 0.35 

mm , fill as shown 
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 Feature Symbol Feature code Digital Drawing Specifications 

41.  
NORTH ARROW 

 

 

WA00103110 Line weight – 0.35 mm 

For A1 Sheet:  

Straight line of arrow 130.0 mm, 

oriented NS. Arrow point base 4.5 mm 

offset on upper side of line, arrowhead 

60.0 mm long. 

Fish mouth semicircle and arc of gill 

arch 5.0 mm diameter, eye 1.0 mm dot at 

centre of gill arc. 

Dorsal line of fish and tail, part of 60.0 

mm diameter circle, “hook” of tail, 12.5 

mm diameter semicircle with lines 

connected to complete tail. 

 

For A2 Sheet: Same as for A1 sheet 

except: Straight line of arrow 95.0 mm, 

Arrow point base 3.0 mm offset, 

arrowhead 45.0 mm long. Fish mouth 

semicircle and arc of gill arch 4.0 mm 

diameter, dorsal line of fish and tail, part 

of 54.0 mm diameter circle, “hook” of 

tail, 9.0 mm diameter semicircle. 

 

 Note: The "fish body" is placed on the 

upper part of the symbol. The symbol 

can be rotated in required. Right or left-

hand orientation is acceptable if the 

arrow is vertical.  
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 Feature Symbol Feature code Digital Drawing Specifications 

42.  
DYKE 

 

HB09450000 Line weight - 0.3 mm, line segments 2.0 

mm, extent as requested 

 

43.  
PIPELINE 

-Gas 

-Water 

-Oil 

 

P: EA21400000 

PG: EA21400270 

PW: EA21400450 

PO: EA21400120 

 

Line weight – 0.3 mm, extent as 

requested, identification letters in 9 point 

type every 5-10 cm.  

 

44.  
DITCH, FLUME, 

PENSTOCK 

 

D: GA08800000 

F: GA11500000 

P: GA21050000 

 

Line in 0.5 line width, text labels in 9 

point type, First letter of word in 

uppercase, remainder in lowercase 

letters (Ditch, Flume, Penstock; as 

required).  

 

45.  
WOODED AREA 

 

 

JA33750000 3.0 mm arcs, from 4.0 mm diameter 

circle segments, in line weight 0.25 mm 

 

46.  
PAVED ROADS 

 

 

DA25100000 0.5 mm line weight. in two parallel lines 

to scale, minimum 2.0 mm separation 

 

47.  
GRAVEL & 

LOGGING ROADS  

DA25000120 0.35 mm line weight. in parallel 

segments 10.0 mm long, spaces 1.0 mm, 

width to scale with a minimum 2.0 mm 
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 Feature Symbol Feature code Digital Drawing Specifications 

MAIN  separation 

 

48.  
GRAVEL & 

LOGGING ROADS - 

ROUGH AND 

SECONDARY 

 

DA25000110 0.5 mm line weight, line segments 3.0 

mm long, spaces 1.0 mm. If indicated by 

author label 4 x 4 in 10 point type  

 

49.  
TRAIL OR 

PORTAGE 

 

DC31700000 0.3 mm line weight, line segments 3.0 

mm long, spaces 1.0 mm. Label "Trail" 

in 10 point type where confusion may 

occur  

 

50.  
HIGHWAY 

NUMBER 

 

 

KA07950000 Symbol is circle 6.0 mm diameter, in 

line weight 0.35 mm, number in 10 point 

type 

 

51.  
BRIDGE OR 

OVERPASS  
DD93250000 Symbol in line weight 0.5 mm, with  

minimum length 7 mm, wings 45  

 

52.  
TUNNEL OR 

UNDERPASS  

DD32200000 

DD93220000 

DD32350000 

(underpass) 

Symbol is in line weight 0.5 mm, with 

minimum length 7 mm, wings 45  

 

53.  
FOOTBRIDGE  DD03100000 Symbol is in line weight 0.5 mm, 

minimum length 5 mm, wings 45  

 



Bathymetric Standards For Lake Inventories 

36 March 2009 

 Feature Symbol Feature code Digital Drawing Specifications 

54.  
FORD 

 

GA11600000 Symbol in line weight 0.5 mm, part of 9 

mm diameter circle 

 

55.  
RAILWAY 

 
DE22800000 Track and ties in line weight 0.35 mm, 

ties 2.0 mm long, 10.0 mm between ties. 

Label in 10 point type text 

 

56.  
CULVERT 

 

 

 

 

PI30005000 

 

  

Symbol –7.0 mm square in 0.5 mm line 

weight. 6.0 mm circle and curve in 0.35 

mm line weight 

 

57.  
BUILDING 

 

 

 
BR03300000 Shown as filled black 3.0 mm square if 

when drawn to scale, it comes to an 

overall size of less than 3.0 mm. 

Otherwise shown in open outline done in 

0.35 mm line weight (to scale).  

 

58.  
POWER LINES 

WITH POLE 
 EA16400000 Power line shown as line in line weight 

0.25 mm, poles in solid fill circles 1.5 

mm in diameter, centered on line and 

20.0 – 50.0 mm apart  

 

59.  
POWER LINES 

WITH  TOWERS 
 CC90000000 Power line in 0.25 mm line weight, 

towers - crossed 2.0 mm squares in 0.3 

mm line weight, 20.0 to 50.0 mm apart 

or as shown by author 



 Bathymetric Standards For Lake Inventories 

March 2009 37 

 Feature Symbol Feature code Digital Drawing Specifications 

 

60.  
MAP JOIN LINES 

 

WA00105110 Line weight - 0.50 mm, segments 15.0 

mm long, spaces 2.0 mm, label in 10 

point type uppercase text outside lake 

area 

 

61.  
RIVER AND 

CREEK NAMES 

 

KB14250000 Labels in 10 to 14 point type italic 

upper/lower case text 

 

62.  
UNLISTED 

ANNOTATIONS 

 

 

KC90000000 Labels in 9 point type upper/lower case 

text as required where noted by author 

 

63.  
CLIFF OR CUT 

 
HB05650000 Outline in line weight 0.35 mm, 

hatching in 0.3 mm line weight with 2.0 

mm separation, extent as shown by 

author 

 

64.  
WEIR OR 

COUNTING FENCE 
 

 

PI40002000 5.0 mm diameter circle in 7.0 mm square 

or as set by author, in 0.35 mm line 

weight, labeled in 9 point type 
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Appendix B:  Bathymetric Map Header 
Information 

Appendix B provides information and specifications required to complete the header block of the 

final Bathymetric map. 

 

Title Details Font 

Surveyed by The name of the crew leader of the bathymetric 

survey 

12 point Medium 

Helvetica  

Date The date or dates of the survey as month/day/year 

(mm/dd/yyyy). 

12 point Medium 

Helvetica  

Outline source The source of lake outline. Outline source is 

usually an air photo (two or more for larger lakes 

over 400 ha), or a TRIM map, when a uniform set 

of photographs is not available. Record the date 

and specs of the orthophotograph. For TRIM map, 

record map number, map edition number and date. 

12 point Medium 

Helvetica; 

All headings: upper 

case;  

data: mixed upper 

and lower 

Elevation (lake) 

Surface Area (lake) 

Area above 6 m contour 

Volume (lake) 

Mean Depth (lake) 

Maximum Depth 

Perimeter -Main Shore 

Perimeter – Islands 

Bench Mark (height) 

Rounding of value is applied before recording the 

information in the map title block. The uncertainty 

of the lake surface elevation and/or variance must 

always be noted, if known. 

 

Mixed upper and 

lower case 12 point 

Medium Helvetica  
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Title Details Font 

BC government logo 

Ministry of Environment 

 11 point Medium 

Helvetica 

Branch name  12 point Medium 

Helvetica (all 

upper case) 

Section name  Mixed upper and 

lower case 11 point 

Medium Helvetica 

Lake name In the case of a "name of record" or an alias name 

for an officially unnamed lake, an asterisk * is used 

to indicate that the name is not official.  

 

30 point Medium 

Helvetica Italic. 

Reduce font if Lake 

name too long 

The following section uses the font described here, unless noted otherwise: 

Headings: Uppercase12 point Helvetica medium Italic  

Data: Mixed upper and lower 12 point Helvetica medium Italic  

Watershed code Watershed code of  the lake outlet to the first set of 

trailing zeroes (from the Freshwater Atlas) 

 

Waterbody ID The Waterbody Identifier  is a 5-digit,  4-character 

code given to each water body by the GIS section, 

and available from the web site 

 

UTM (Universal 

Transverse Mercator) co-

ordinate 

The UTM co-ordinates, to the nearest metre, at the 

lake outlet or at the geographic centre of the lake if 

no outlet is present. Record in Zone, Easting, and 

Northing sequence. 

 

Date The date when the bathymetric map was 

completed. Record as month (written out) and year 

(in four digits). 

 

Scale Record the numerical scale ratio (such as 1:3000, 

etc.) or "see scale bar". A scale bar is a scale with 

markings to indicate a zero point and a bar with 

metres marked on it that correspond to the scale. 

 Use scale ratio on full (original)-sized plots and 

remove and replace with scale bar when map is 

reduced 

“see scale bar” in 

14 point Medium 

Helvetica Italic 

Data QA / QC Record the name of the GIS software package, and 

the initials of the person who reviewed and cleaned 

the point data.   
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Title Details Font 

Contours If the contouring was done manually, record the 

initials of the person. If the contouring was done 

using a computer, record the name of the software 

package. 

 

Revision Date Record the date when any revisions to the map 

were made. Revisions include any corrections of 

errors that were discovered at a later date, or any 

recalculations or changes to the map drawing. 

 

Tech. Check Initialed by the person conducting the technical 

check for contour positions, all the location and 

volumetric data, and the feature and line placement 

on the map. 

 

Approved Provide name of the government representative 

conducting the final check on the map.  

 

NTS No. The NTS (National Topographic System) mapsheet 

number on which the lake is located, e.g., 82M/5. 

 

16 point Medium 

Helvetica Italic. 
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Appendix C: Bathymetric Equipment Checklist 
 

Reference Materials 

□ Air Photo 

□ Air Photo Enlargement 

□ Lake Outline maps on waterproof paper 

□ Maps (TRIM; NTS) 

□ Lake Survey Form (FDIS) 

Boat and Motor 

□ Boat to suit lake size and access * 

□ Motor (electric or gas) ** 

□ Fuel tank and fuel (if using gas motor) 

□ Oars (with half meter depth marks) 

□ Boating safety equipment (anchor and line, bailing bucket, PFDs) 

□ Tools and spare motor parts (prop, shear pins, spark plugs, etc.) 

Sounding equipment 

□ Sounder with clear plastic rain-shield 

□ Lead line or pole marked in decimetre intervals, meters numbered 

Battery 

□ 12V Marine Battery 

□ Spare 12V Marine Battery or Battery Charger 

Benchmark 

□ Spike 

□ Fluorescent spray paint 

□ Other appropriate benchmark 

□ Hammer 

□ Level 

□ Tape measure 

General 

□ Clipboard 

□ Pencils 

□ Ruler 

□ Rangefinder 

□ Compass 

□ First aid and communications as per WCB Regulations 
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* Aluminum, inflatable or folding boats can be used depending on logistics.  Each has advantages and 

disadvantages in certain situations. 

** Some lakes have boating restrictions.  Electric motors may be required in these cases. 
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Appendix D: Lake Bathymetry Digital Data 
Manipulation 
 

Workflow for taking data from Lowrance Depth Sounder and 
creating Bathymetric Products (Contours, Volume Calculations, 
Views, etc.) 

In SonarViewer v1.2.2 from Lowrance Electronics 

Open the file downloaded from the MMC card 

Lowrance proprietary file format is .SLG  

File > Output Chart Information > save it as a .CSV file format 

Note: If this doesn‟t seem to be working, try opening the .SLG file from within Sonar Viewer 

by using File > Open Chart.  There seems to be a bug if the output operation is performed on 

a file that was opened by double clicking. 

In Excel 

Open the .CSV file and then clean out the bad data  

Sort the data based on the DepthValid field and then Delete all of the (F)alse values. Do the 

same with the PositionValid field – delete all the bad records 

Performing these two steps will greatly reduce the number of rows in the spreadsheet 

Do conversion from Lowrance‟s proprietary co-ordinate system which shows up in the .CSV 

as columns  

These formulas will give Lat Long values in decimal degrees – which will eventually need to 

be converted into UTM 

PositionX=(DEGREES(A2))/6356752.3142 

PositionY=DEGREES((2*ATAN((EXP(B2/6356752.3142))))-PI()/2) 

Convert the depth from positive ft values to negative m values and add a foot (or however far 

below the surface of the water the transducer was mounted) for transducer depth 

z=((C2+1)/3.28)*-1  

Save this as „LakeNameCleaned‟.CSV 

In ArcGIS 

Find the most recent orthophoto for that mapsheet area and start a new project (MXD) 

Add in the XY data as points – using the same projection as the photo (i.e. - NAD 83  UTM 

Zone 11 for the case of the East Kootenays) 

Tools > Add XY Data  

Because the XY points are in Lat/Long co-ordinates, they may have to be re-projected within 

ArcGIS. 
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Save this point file as a shapefile Export > Data > Shapefile  

QA / QC the data by making sure the points line up with the image of the lake and also that 

the values make sense for the relative position on the lake.  Do this by symbolizing the points 

with graduated symbols 

Properties > Symbology > Graduated Symbols > use the Z value – with largest circles for 

the deepest points and smallest circles for the shallow areas.  This will intuitively allow the 

„zingers‟ to be picked out where there are large symbols in shallow areas (or vise-versa) – 

these points can be deleted when they are obviously in error.  

In ArcCatalog – create a new shapefile – polygon – with no Z values 

Digitize shoreline to create blanking file to be used in Surfer – save as a polygon file 

Buffer this file inwards by -0.5m (linear unit) 

ArcToolbox > Analysis Tools > Proximity > Buffer  

To create another polygon that is slightly smaller. 

Create point files for both of these polygons  

XToolsPro > Feature Conversions > Convert Features to Points 

Generate co-ordinates for these points  

XToolsPro > Table Operations > Add X,Y,Z Co-ordinates  

The co-ordinates for the outer ring of points will be used to create the blanking File (.BLN) in 

Surfer and the inner ring of points will be joined to the main XYZ point coverage to represent 

the shoreline.   

ArcToolbox > Data Management Tools > General > Merge 

Give a Z value of -0.5m (or some other shallow value) to all the perimeter points that have 

been appended to the others and have a default of 0. (in a Table Edit session) 

This main point file now has XYZ values for all of the sounding points as well as the 

shoreline points in one file that will be brought into Surfer for the gridding operation. 

In Excel 

Open this .dbf file and then save X, Y and Z columns as a .CSV format for importing into 

Surfer 

Generate the fault file by taking X and Y points from larger perimeter file , replace top row 

headings with code (#of rows, 0 ) and save as a .CSV file.  Then go into Windows Explorer 

and change the file extension to .BLN format  

In Surfer 

Import the point data and prepare it for interpolation.   

Grid > Data > (select your XYZ.csv file) and make sure the field mappings (X, Y and Z) 

match up and then select your interpolation method (only  Inverse Distance to a Power, 

Minimum Curvature, Nearest Neighbor and Data Metrics support using faults which is 

required to create a break at the shoreline.)   

Under Advanced Options, define the Fault file (second box down) to tell it not to interpret 

beyond the polygon defined by those points.   
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Execute – sometimes this can take quite a while depending on the interpolation method 

chosen and the number of data points – sometime many hours! 

Save output as a grid (.GRD) file  

Make contour and shaded maps as required  - save as plot files (.SRF) to be opened again 

later if the graphics that have been created are satisfactory. 

Export contours to take back into ArcMap (.shp file of contours is one of desired outputs) 

Must have contour map open and be clicked on the „Contours‟ layer and then go 

Map > Contour Map > Export Contours 

This will export a .DXF file which is a CAD file  

Back in ArcGIS 

Import this into– make sure to use the „CAD Feature Dataset‟ which breaks down the file into 

its component parts.   Once this is in ArcGIS, right click on the contours component and go 

Data > Export Data and then save it as a shapefile. 
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Glossary 
Air Photo Flight Index: Maps showing flight lines and aerial photograph numbers. These are 

available through GeoBC and viewable on iMap. 

Bathymetry: The measurement of depth of any body of water e.g., streams, lakes, seas and oceans. 

Benchmark: A mark on a permanent object indicating elevation and serving as a reference in 

topographical surveys (e.g., like measuring a lake‟s water level height). 

Clinometer: A device used for measuring the slope angle to the horizontal in degrees or percentage. 

Debris: Usually materials deposited near the shoreline or floating in the lake. In streams it may occur 

as clumps, jams, or scattered within the water course. This can be organic, such as logs, 

vegetation etc., or inorganic, such as boulders, etc., dislocated from the banks. 

Depth (water depth): The vertical distance from the water surface to the bed of the water body. 

Contour numbers: The depth in metres (for Fisheries purposes) of a particular contour line. For 

Water Management program, this refers to elevation above Geodetic Datum of Canada (mean 

sea level for Water Management). 

Drainage: The flow of water in a particular area related to topography. 

E-Line: A depth sounding transect along the longitudinal axis of a lake. 

Embayment: A bay-like formation on the shoreline of a lake. 

Ford: A shallow area in a stream or lake used for crossing. 

Landmark: A distinctive surface feature used to identify locations, etc. 

Line level: Carpenter‟s level bubble that hangs on a line. 

Littoral zone: Shallow area around the edge of a lake, typically the area less than 6 metre deep. 

Marsh: A tract of soft wet land identifiable by particular herbaceous marsh plants like marsh 

marigold, sphagnum moss, skunk cabbage and sedges, bulrushes, etc. 

Muskeg: A thick deposit of partially decayed vegetable matter of wet regions with a sparse 

coniferous tree cover. In BC, the dominant plant-cover contains sphagnum species of mosses 

and black spruce. 

Perimeter: The length of the boundary of a particular area, e.g., a watershed, lake etc. 

Primary lake: In Reconnaissance (1:20 000) Fish and Fish Habitat inventories these are lakes that 

play a dominant role. These generally have the largest surface areas, and (or) are central in a 

cluster or chain of lakes. 

 

Shoal: A shallow area of the lake bottom, usually ~ 0.75m, which may pose as an obstruction to small 

watercraft. 

Snag: (a) A standing dead tree. (b) Sometimes a submerged, fallen tree. The top of the tree is usually 

exposed or only slightly submerged. 

Spot sounding: A depth sounding obtained at a known spot (often by a marked oar, tap, lead line or 

sounder. 
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Surface area: The total area of the water surface within the lake shoreline minus the area occupied by 

islands, if present. 

Swamp: Wet spongy land saturated and sometimes partially or intermittently covered with water. In 

BC, swamps are often associated with shrubs, like willows, and wetland plants like bulrushes, 

cattails etc. 

Transect: A set of readings (depth, temperature, pH, etc.) along a straight line across a feature (e.g., 

lake, river, hill slope) from a known start point to a known end point. 

Turbulence: The motion of water where local velocities fluctuate and the direction of flow changes 

abruptly and frequently at any particular location, resulting in disruption of laminar flow.  

Volume (of lakes): The amount of water a lake contains, measured usually in cubic metres (also 

quoted in dam
3
, acre-feet or litres, depending on the size of the lake and/or the date of survey). 
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